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This vocal sample-based "instrument" was created by cutting, editing and programming a selection of 
the earliest known sound recordings, as restored by the non-profit group First Sounds 
(www.firstsounds.org).   This original method of recording, called ‘Phonautography’ was invented in 
the early 1850s, by French inventor Édouard-Léon Scott de Martinville.  The sounds were captured 
by projecting the voice and other sounds into a cylindrical horn attached to a stylus, which in 
transfered the vibration into lines over the surface of oil lamp soot-blackened sheets of paper. 

They had been preserved by the archives of the French Academy of Sciences (Académie des 
sciences de l'Institut de France).  One of First Sounds’ founders, David Giovannoni, tells us that “the 
Academy is the institution whose stone walls have preserved these magnificent documents through 
social upheavals, political revolutions, world wars, and other disturbances since Scott's deposit of 
Gamme de la Voix in 1861 -- just five years short of the bicentennial of the Academy's founding in 
1666.”

Essentially, these recordings were purely optical and no device existed which could translate the 
recorded acoustic information back into sound, until the First Sounds organization acquired the 
preserved papers in France and brought them to scientists at Lawrence Berkeley National 
Laboratory in Berkeley, who devised a method of scanning and deciphering the images .

The 1860 recording we chose for this library features a D major scale being sung by a single voice, 
presumably that of the inventor. The original capture left the pitch one octave too high, giving the 
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resulting timbre a female vocal quality. The newer version was translated at the proper original 
pitch, revealing the singer to have been a man. We used both audio files to give us a full two octave 
range of notes to work with.  

You'll notice that the distortion of pitch, tone and general lack of preserved acoustic information 
yields a smeared and warbling quality, somewhere between a voice and some sort of woodwind and 
possessing a frail and innocent affect. I like it, because it really reminds me of the humble beginnings 
that our modern audio-visual media has grown from and the power to share and explore music and 
sound that our technology has given us. 

First Sounds is an informal collaborative of audio historians, recording engineers, sound archivists, 
scientists, other individuals, and organizations who aim to make mankind's earliest sound recordings 
available to all people for all time. First Sounds was founded in 2007 by David Giovannoni, Patrick 
Feaster, Richard Martin and Meagan Hennessey.

Édouard-Léon Scott de Martinville's Phonautograms
Gamme de la Voix - Vocal Scale (May 17, 1860)
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SOUNDIRON
Phonautograms
 
Historic voice recordings 
3 powerful open-format Kontakt .nki and Sforzando .sfz instrument presets
107 Samples
278 MB Installed 
16bit / 44.1kHz and 48kHz wav samples (non-compressed)
Dozens Of Room, Hall and Special Effect Acoustic Environments
Performance Controls and Rack Multi-FX

Note:  The full version of  Kontakt 5.1 or later is required for all Kontakt presets in this library. The free Kontakt “Player” and 
Libraries rack do not support this product. See Page 4 for details.

All SFZ presets require a SFZ v2.0 compatible sampler or synthesizer engine that can read all standard sfz opcodes.  We highly 
recommend the free Sforzando plugin, available for PC/OSX in VST, AU, RTAS & standalone player formats. See Page 4 for details.
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Format

All of the sample content is included as standard open PCM wav 
files to allow you easy access to manipulate, reprogram and 
customize the sounds however you wish. We know that it’s 
important for many users to be able to go beyond the limitations of 
any one format, so we’ve kept this library’s directories and files 
open for our advanced users.  As a professional, you may have your 
own workflow or format requirements, and we trust that you'll 
respect our hard work and won't share this content with anyone 
who hasn't paid for it. 

You’ll need the full retail version of Native Instruments Kontakt 
5.1.0 or later to use the nki presets in this library.  The free Kontakt 
“Player” and any other version of Kontakt that came bundled with 
another library or software product (other than NI’s full 
“Komplete” package) don’t support this library.  The free Kontakt 
Player is NOT a full version of Kontakt and cannot load or play 
standard open-format Kontakt instruments, wav samples or 
libraries.  Please read all instrument specs and software 
requirements before purchasing this or any other Soundiron 
products to see the full list of software requirements, features and 
format compatibility for each library. 

Fidelity

The studio content in  this library was recorded in dual mono using 
two different large diaphragm microphone types (Cardioid and 
Omni) at 48kHz / 24bit. The hall content was recorded in a large A-
Frame sanctuary hall. Sonic impurities from the environment, body 
movement, outside sources, wildlife, structural movement and 
natural mouth and throat sounds may be present in  the samples. 
Our goal is to preserve and accentuate the natural live qualities in 
our instruments without overly modifying and sterilizing the 
recordings. Therefore, please keep in mind that this library isn’t 
designed to provide perfectly sterile result.

System Requirements

Please be aware that many instrument and multi-instrument 
programs in  this library are extremely ram/cpu and hard disk-
streaming resource intensive. We highly recommend that you have a 
64-bit operating system (Windows or OSX) with at least 4GB of 
system ram, a multi-core cpu and a 7200 rpm SATA or SSD hard 
disk before purchasing this particular Soundiron library. Large 
sample sets like those found in this library may load slowly and may 
cause system instability on some machines. 

Download

We provide the Continuata Connect download manager to offer 
high-speed, reliable and fully automated library downloading and 
installation. Download and run the latest version for your OS (PC 
or Mac) before proceeding.  You may also need to add special 
permissions to your security software for the downloader, if it 
blocks applications from accessing the web. 

Next, copy-paste your download code from your download email 
into the Code box in the downloader window. Press the download 
button and select the location you'd like to download and install the 
library. It will automatically start downloading the file(s) and then 
error-check, extract and install the finished library. Once installation 
is fully complete, you can remove the .rar download files and store 
them in a safe place as a back-up copy.  We always recommend 
downloading the latest version of our downloader before you 
begin. The link in your email will always take you to the latest 
version.  

Don't move, rename, delete or modify any of the files or folders 
created during the download until after you see the status message 
for all files in your download queue display the word 
"INSTALLED". Please don't close the downloader while it's 
actively downloading, unless you press the pause button first. To 
resume downloading, press the Resume button. If you need to 
resume downloading after closing the downloader, run it again and 
enter your code and press Download again. Then select the same 
download/installation location on your computer that you chose 
originally. 

If the downloader reports a DL Error or Install error, it will 
automatically try to download the file again until it successfully 
downloads and verifies all the data it needs. It’s best to allow it to 
finish the process before trying to move or access the library data. 
Please see your download email for more detailed instructions. 

If you have any trouble with our Downloader utility or prefer to 
use your browser or another download manager, log into your 
personal manual download page on our website, by using the direct 
link in your download email. Log in using your download code. Or, if 
you used the downloader originally, but you need to re-install the 
library manually for any reason at a later time you can always re-use 
the original rar files.  To do that, you'll need Winrar, UnrarX or 
another full-featured Rar extraction utility to extract and install the 
library. Please note that Stuffit Expander and Winzip DON’T 
support many types of common rar files.

Preset Loading

Once installation is complete, you can browse and load the 
included .nki presets using the Files, Quickload or Database tabs in 
the Kontakt Browser, or through the main File load/save menu.  
Please allow any current preset to finish loading completely before 
loading a new one.  You can’t use the Libraries view to load 
standard open-format Kontakt Instruments like this library.  Only 
locked “Powered-By-Kontakt” Libraries are visible to that propriety 
browser view.  The “Add-Library” function does not support this 
product or any other open-format Kontakt library. This library 
doesn’t require any special activation. 

SFZ Preset Loading

Once installation is complete, you can browse and load the 
included .nki presets in any SFZ 2.0 compatible sampler or 
synthesizer plugin or engine. There are a variety of samplers 
available that can read this format, but not all of them support 
every feature in the same way and some features may not be 
supported at all by some programs. We highly recommend 
Sforzando by Plogue for best results. Download the latest version 
of Sforzando here: http://www.plogue.com/downloads/

To load SFZ presets in  SForzando, first install Sforzando and then 
run it in standalone mode or as a plugin in your sequencer 
environment. Then simply Drag & Drop one of the .sfz files located 
in the SFZ folder of this library directly into the Sforzando plugin 
window to load it, or click on the File menu to import presets as 
well. As soon as a preset is loaded, it's ready to play. If you'd like to 
load multiple presets at the same time, simply load additional 
instances of Sforzando in  your sequencer. You can route audio and 
midi for each instance independently, giving you full control over 
your mix and performance, with up to 128 stereo voices per 
instance.

If you've loaded the player into your sequencer, make sure to route 
midi in and audio out of the plugin to enable playback. If you run it 
in stand-alone mode, make sure that you enable your midi input and 
audio driver output in the Tools > Preferences drop-down menu at 
the top. 
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Vocal Sustains (Gamme de la Voix)
The 1860 recording we chose for this library features a D major scale being sung by a single voice, presumably 
that of the inventor. The original capture left the pitch one octave too high, giving the resulting timbre a female 
vocal quality. The newer version was translated at the proper original pitch, revealing the singer to have been a 
man. We used both audio files to give us a full two octave range of notes to work with.  

Swell - (CC 72)
This knob controls dynamic swelling. 

Attack - (CC 74)
This knob controls the sharpness of initial note attack. Higher values soften the attack.

Offset - (CC78)
This controls the amount of sample start offset allowing you to jump ahead into samples to modify the the beginnings of notes. 

Release - (CC76)
This knob controls the release fade-out time. Lower values result in faster releases. 

Pitch
This transposes the pitch up or down for the whole instrument.

Pitch Keyswitch Controls
These controls can be used to set the location of the pitch transposition key switches, which allow you to shift the tuning of the 
instrument up or down in semitone increments automatically.  They can be moved to any location you wish on the key range. You can 
type in new value or press the SET button and select the new key to anchor the key switches to by midi.

Waveform Window
Provides a visual representation of the current sample. 

Custom Control Automation
If you wish to save the knob values in the preset after changing them, save the preset. The values will be loaded the next time you open 
the preset. To reset a knob to it's default position, simply Right Click on the knob with your mouse (Command Click for Mac). You can 
also assign any midi controller or host automation envelope to any of the knobs and buttons by using the automation assignment 
menu on the left side of Kontakt, under the "Auto" tab in the Browser area. Just click on the CC number you want to assign and drag 
your cursor onto the knob or button you want to automate while holding down your mouse button. Then set the "From %" and "To 
%" values to the min and max value range you want the automation to stay within. Setting the From % value higher than the To % value 
will invert the direction of the automation. To remove the automation from a control, press the Remove button at the bottom. 
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Ambient Drones, Pads, Soundscapes and Atmospheres
This contains a wide variety of re-synthesized content that we created by manipulating the original Gamme de 
la Voix source recording with specialized tools and techniques to create organic soundscapes, atmospheres, 
pads and lead “synths”, in 31 different flavors.

“Sound” Selector Menu
This menu chooses the current ambient sound selection. You can also use the Keyswitches to load any of the different sound choices.  
This menu is only used in the Phonambiences preset.  

Swell - (CC 72)
This knob controls dynamic swelling. 

Attack - (CC 74)
This knob controls the sharpness of initial note attack. Higher values soften the attack.

Offset - (CC78)
This controls the amount of sample start offset allowing you to jump ahead into samples to modify the the beginnings of notes. 

Release - (CC76)
This knob controls the release fade-out time. Lower values result in faster releases. 

Pitch
This transposes the pitch up or down for the whole instrument. 

Sound Selector Keyswitch Controls
These controls can be used to move the location of the sound selector key switches to any location on the key range. You can type in 
new value or press the SET button and select the new key to anchor the key switches to by midi. These key switches control the 
sound drop-down menu and load different ambiences and tonal pads from the available list. 

Pitch Keyswitch Controls
These controls can be used to set the location of the pitch transposition key switches, which allow you to shift the tuning of the 
instrument up or down in semitone increments automatically.  They can be moved to any location you wish on the key range just like 
the Sound Selector Key switches. 

Waveform Window
Provides a visual representation of the currently playing sample.
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Drums
The Phonautogram Drums are percussion elements that we created by manipulating the sound recordings in 
the same way we created the ambiences, but with the gola of crafting sharp electro percussion sounds that 
could be used in a variety of ways. You’ll find punchy kicks, sharp snares, hats, clicks, blips, pops and several 
dozen other sound effects here. 
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Attack - (CC 74)
This knob controls the sharpness of initial note attack. Higher values soften the attack.

Offset - (CC78)
This controls the amount of sample start offset allowing you to jump ahead into samples to modify the the beginnings of notes. 

Release - (CC76)
This knob controls the release fade-out time. Lower values result in faster releases. 

Pitch
This transposes the pitch up or down for the whole instrument.

Pitch Keyswitch Controls
These controls can be used to set the location of the pitch transposition key switches, which allow you to shift the tuning of the 
instrument up or down in semitone increments automatically.  They can be moved to any location you wish on the key range. You can 
type in new value or press the SET button and select the new key to anchor the key switches to by midi.

Waveform Window
Provides a visual representation of the current sample. 

Custom Control Automation
If you wish to save the knob values in the preset after changing them, save the preset. The values will be loaded the next time you open 
the preset. To reset a knob to it's default position, simply Right Click on the knob with your mouse (Command Click for Mac). You can 
also assign any midi controller or host automation envelope to any of the knobs and buttons by using the automation assignment 
menu on the left side of Kontakt, under the "Auto" tab in the Browser area. Just click on the CC number you want to assign and drag 
your cursor onto the knob or button you want to automate while holding down your mouse button. Then set the "From %" and "To 
%" values to the min and max value range you want the automation to stay within. Setting the From % value higher than the To % value 
will invert the direction of the automation. To remove the automation from a control, press the Remove button at the bottom. 
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The Mod FX module features Chorus, Flanger and Phaser 
effects.

Power Button - Toggles the effect on and off.

Dropdown - Use this dropdown menu to select the active 
effect.

Rate - This knob controls the Rate of the selected effect.

Feedback - This knob (not available in Chorus mode) control 
the amount of feedback for the active effect.

Phase - This knob controls the Phase of the active effect.

Depth - This knob controls the depth (intensity) of the 
selected effect.

Mix - This knob controls the amount of wet and dry output of 
the effect. Values left-of-center reduce the wet level, while values 
right-of-center keep wet levels the same but reduces the dry 
level.

Effect Types and Controls

FX RACK
The FX Rack tab contains our advanced, flexible FX Rack that integrates many of Kontakt’s built-in effects. The following section 
describes all of the available effects. The FX Rack is accessible in all presets by clicking on the UI tab at the bottom of the instrument 
labeled “FX Rack.”

Mod Controls

The Dynamics FX module is a configurable compressor.

Power Button - Toggles the effect on and off.

Threshold - This knob controls the volume threshold of the 
compressor.

Ratio - This knob controls the ratio of the compressor. The 
value is displayed to the right.

Attack - This knob controls the attack time of the 
compressor.

Release - This knob controls the release time of the 
compressor.

Makeup - This knob controls the makeup of the compressor.

Dynamics Controls
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The Drive FX module features a variety of distortions: 
Distortion, Skreamer, Tape Saturator and De-Rez (Lo-Fi).

Power Button - Toggles the effect on and off.

Dropdown - Use this dropdown menu to select the active 
distortion effect.

Drive - This knob controls the amount of the distortion effect.

Volume - This knob controls the output level of the 
distortion effect.

Degrade - This knob (only available in De-Rez mode) control 
the amount of bit crushing that the Lo-Fi effect does.

Lows - This knob (when available) controls the level of low 
(bass) frequencies.

Highs - This knob (when available) controls the level of high 
(treble) frequencies.

Tone - This knob (only in Skreamer mode) controls the tone 
level of the Skreamer effect.

FX Rack continued...

Drive Controls

The Amp FX module is a configurable amp simulation effect. It 
includes the “Twang” and new “Jump” amp simulators.

Power Button - Toggles the effect on and off.

Dropdown - Use this dropdown to select between the 
available amp types: twang and jump.

Volume - This knob controls the volume output level of the 
amp sim.

Drive - This knob controls the amount of extra gain on the 
amp simulator.

Lows - This knob controls gain of low (bass) frequencies.

Mids - This knob controls the gain of mid-level frequencies.

Highs - This knob controls the gain of high (treble) 
frequencies.

Boost Button - This button (only available in the Jump amp 
sim) toggles HiGain mode on and off. The Volume is adjusted 
-9dB when activated to maintain relative volume while 
increasing the drive.

Presence - This knob (only available in the Jump amp) 
adjusts the presence of the effect.

Amp Controls

The Cab FX module is a configurable cabinet (speaker) 
simulation effect.

Power Button - Toggles the effect on and off.

Dropdown - Use this dropdown to select between the 
available cabinet types including the Rotator cabinet effect..

Volume - This knob controls the volume output level of the 
cabinet sim.

Air - This knob controls the amount of the “Air” in the 
cabinet effect, simulating distance between the virtual mic and 
cab.

Size - This knob controls size of cabinet effect, effectively the 
size of the simulated cabinet.

Fast Button - This button (available only with the Rotator 
cabinet type) toggles the rotation effect of the cabinet from 
slow to fast.

Cab Controls
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FX Rack continued...

The Delay FX module is a configurable Delay effect.

Power Button - Toggles the effect on and off.

Rate - This knob controls the time between delays. Higher 
values mean a longer time between delays, creating a more 
pronounced echo.

Damping - This knob controls the damping of the delay 
effect, which attenuates and damps each successive echo.

Pan - This knob controls the amount of stereo panning of the 
delay effect.

Feedback - This knob controls the feedback of the delay 
effect. High values can cause and endless loop.

Mix - This knob controls the amount of wet and dry output of 
the effect. Values left-of-center reduce the wet level, while 
values right-of-center keep wet levels the same but reduces the 
dry level.

Delay Controls

The Rever FX module allows users to load reverb impulses to 
simulated real-world spaces or effects. See Page 3 for details.

Power Button - Toggles the effect on and off.

Custom Button - Turning this  “On” bypasses the our built-
in impulses so you can save presets with your own impulses in 
the Insert FX module through Kontakt’s Editor view. 

FX Menu - This menu allows you to select one of our special 
effect convolutions. Selecting an impulse from this menu 
overrides and unloads any currently loaded impulse from the 
Spaces menu.

Rooms Menu - This menu allows you to select one of our 
real-world environmental convolutions. Selecting an impulse 
from this menu overrides and unloads any currently loaded 
impulse from the Effects menu.

Lo Pass - Sets the low frequency cut-off of the impulse 
response, allowing you to dull and darken the sound.

Hi Pass - Sets the high frequency cut-off of the impulse 
response, allowing you to remove rumble and low end.

Size - Sets the simulated room size of the convolution.

Delay - Sets the amount of pre-delay time before the wet 
signal is returned

Mix - This knob controls the amount of wet and dry output of 
the effect. Values left-of-center reduce the wet level, while values 
right-of-center keep wet levels the same but reduces the dry 
level.

Reverb Controls
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SFZ Presets
The 3 sfz format presets are designed in the common open sfz format, which can be loaded into a variety of 
soft synths and samplers. However, we make use of several advanced opcode features that aren’t supported by 
all sfz-compatible software. We strongly recommend that you use the free SForzando Player by Plogue 
Software. It is a dedicated engine for SFZ instruments that supports all major plugin formats and it can run as a 
stand-alone app as well. You can download Sforzando by clicking here. 

The Sforzando player allows the instrument to display the same main front panel performance control 
parameters as our Kontakt presets. You can edit the values for each parameter by clicking and dragging the 
values or by automating the midi CC assigned to each one. You can see the midi CC assignment for each 
control in the descriptions below. 

“K-Switch” Articulation Selector Menu
This menu chooses the current ambient sound selection. You can also use the Keyswitches to load any of the different sound choices. 
This preset will load with no sound currently selected. To play the sounds, you must first select one from this menu or by using the key 
switches.  If you are using this preset in a song, it is best to start the track with a key switch to always initialize the sound you want to 
play. This menu is only used in the Phonambiences preset.   

Swell - (CC 72)
This knob controls the volume swell of the instrument, and is not found in the Phonautogram Drums sfz preset.

Attack - (CC 74)
This knob controls the sharpness of initial note attack. Higher values soften the attack.

Offset - (CC78)
This controls the amount of sample start offset allowing you to jump ahead into samples to change the sound and bypass syllables. This 
knob also moves the green marker in the waveform window.

Release - (CC76)
This knob controls the release time of notes when. Please keep in mind that this library was recorded in a vocal booth, so the 
maximum release time is short.

Vibrato
This controls the intensity of simulated vibrato, and is not found in the Phonautogram Drums sfz preset.

Sound Selector Keyswitches
These key-switches can be used to control the K-Switch drop-down menu and load different ambiences and tonal pads from the 
available list. The currently selected key switch is colored red. The rest are colored gray. The playable note range for the instrument is 
white. Use these if you wish to automate sound selection in real-time and to initialize the sound on midi playback. 
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NKI Preset List
 
** Please note that all presets listed are designed to be used with the 
full version of Kontakt 5.1.0 or higher. 

Phonautogram Sustains (Gamme de la Voix).nki 
Transposition key switch C-2 - C0, Playable key range C#0 - 
G8.  See Page 5 for more info. 

Phonambiences.nki 
Sound Select key switch C-2 - F#0,  Playable key range G0 - 
B6, Transposition key switch C7 - C9. See Page 6 for more 
info.

Phonautogram Drums.nki 
Transposition key switch C-2 - C0, Playable key range C1 - E4. 
See Page 7 for more info.

SFZ Preset List
** Please note that all presets listed are designed to be used with the 
Sforzando player by Plogue. Some features may not be compatible 
with other sfz engines. 

Phonautogram Sustains (Gamme de la Voix).sfz
Playable key range C#0 - G8. The Kontakt GUI, FX Rack panel 
and Transposition key switches are not available in sfz presets. 
However, there is an added Vibrato control feature in this 
preset that allows subtle pitch oscillation. See Page 11 for 
more info. 

Phonambiences.sfz
Sound Select key switch C-2 - F#0. Playable key range G0 - 
B6. After loading this preset, press one of the sound select key 
switchess or click on the K-Switch drop-down menu at the 
top of the Sforzando Player window to activate one of the 31 
different sounds available in this preset. The Kontakt GUI, FX 
Rack panel and Transposition key switches are not available in 
sfz presets. However, there is an added Vibrato control feature 
in this preset that allows subtle pitch oscillation. See Page 11 
for more info. 

Phonautogram Drums.sfz
Playable key range C1 - E4. This preset features Attack, Release 
and sample start Offset controls. The Kontakt GUI, FX Rack 
panel and Transposition key switches are not available in sfz 
presets. See Page 11 for more info. 
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SOUNDIRON 
SOFTWARE LICENSING AGREEMENT

LICENSE AGREEMENT 
By installing the product you accept the following 
product license agreement: 

LICENSE GRANT 
The license for this product is granted only to a 
single individual user.  No unlicensed use is 
permitted.  All sounds, samples, programming, 
images, scripting, designs and text contained in this 
product are copyrights of Soundiron, llc. This 
software is licensed, but not sold, to you by 
Soundiron, for commercial and non-commercial use 
in music, sound-effect creation, audio/video post-
production, performance, broadcast or similar 
finished content-creation and production use. 
Individual license holders are permitted to install 
this library on multiple computers or other 
equipment only if they are the sole owner and only 
user of all equipment this software is installed or 
used on. 

Soundiron allows you to use any of the sounds and 
samples in the library(s) you've purchased for the 
creation and production of commercial recordings, 
music, sound design, post production, or other 
content creation without paying any additional 
license fees or providing source attribution to 
Soundiron. This license expressly forbids any 
unauthorized inclusion of any raw or unmixed 
content contained within this product into any 
other commercial or non-commercial sample 
instrument, sound effect library, synthesizer sound 
bank, or loop or effect library of any kind, without 
our express prior written consent. 

This license also forbids any unauthorized transfer, 
resale or any other form of re-distribution of this 
p roduc t , o r i t s cons t i t uen t sounds or 
programming, through any means, including but not 
limited to re-sampling, reverse engineering, de-
compiling, remixing, processing, isolating, or 
embedding into software or hardware of any kind, 
except where included as part of a multimedia 
product ion, rendered musica l recording , 
performance or finished work of sound design of at 
least 8 seconds or more in length. Licenses cannot 
be transferred or sold to another entity, without 
written consent of Soundiron, LLC.

RIGHTS 
Soundiron retains full copyright privileges and 
complete ownership of all recorded sounds, 
instrument programming, documentation and 
musical performances included within this product. 
All past and future versions of this product, 
including any versions published or distributed by 
any other entity are fully bound and covered by this 
agreement.

REFUNDS 
Downloaded libraries can't be returned, so we can't 
provide refunds or exchanges. We may choose do 
so at our own discretion, but please be aware that 
as soon as you've downloaded it, it can not be 
returned. 

RESPONSIBILITY 
Using this product and any supplied software is at 
the licensee’s own risk. Soundiron holds no 
responsibility for any direct or indirect loss arising 
from any form of use of this product. 

TERMS 
This license agreement is effective from the 
moment the product is purchased or acquired by 
any means. The license will remain in full effect until 
termination by Soundiron, llc. The license is 
terminated if you break any of the terms or 
conditions of this agreement, or request a refund 
for any reason. Upon termination you agree to 
destroy all copies and contents of the product at 
your own expense.  All past and future versions of 
this product, including those released through 
brands other than Soundiron, are covered under 
the terms of this agreement.

VIOLATION 
Soundiron reserves the right to prosecute piracy 
and defend this copyrighted work to the fullest 
extent of US and International civil and criminal 
law. 
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THANK YOU.

Thank you for enjoying the Phonautograms 
by Soundiron, an open-format sample 
library for the Native Instruments Kontakt. 
We’d also like to thank First Sounds, The 
French Academy of Sciences and everyone 
else who worked to preserve and restore 
this awesome piece of history. If you enjoy 
this creation, we hope you’ll check out 
some of our other awesome virtual 
instrument libraries. If you have any 
questions or need anything at all, just let us 
know. We’re always happy to hear from you.   

info@soundiron.com

thanks!

Mike, Gregg and Chris

All programming, scripting, samples, images and text © Soundiron 2013.  All Rights Reserved.
Soundiron is a Registered Trademark of Soundiron LLC

WWW.SOUNDIRON.COM

S
O
U
N
D
IR
O
N
   
   
P
h
o
n
a
u
to
g
ra
m
s 
2

mailto:info@soundiron.com
mailto:info@soundiron.com
http://WWW.SOUNDIRON.COM
http://WWW.SOUNDIRON.COM

